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1. Overview 

Where’sMyStuff (WMS) is a unique, extremely fast disk file indexing and search tool for PC 

computers. It can operate on a range of Microsoft operating systems including Windows 2000 

(Service Pack 4), Windows XP Professional (Service Pack 2) and Windows Vista.  

WMS was designed to allow very rapid indexing and retrieval of any file(s) on your disk(s) - by 

time, using our unique timeline feature as well as any of the other standard file attributes such 

as size, name and directory, etc. 

It is designed for simple organization of your files with tabs for all main file categories, as 

detailed below. It displays all search results as file lists, except for image files, which are 

displayed as thumbnail images or a file list. 

The search program requires 5MB to 100MB of memory, depending on the number of searched 

files listed in the various tabs. The indexer is about 1MB in size, but can require up to 250Mb 

when indexing, depending on the number of disks (up to 4 allowed) and the number of files on 

them. The larger your disks and the greater the number of files to be indexed, the more 

memory you will require. Recommended RAM is 1GB for most users, although 500MB will do 

for those with fewer files. 

ADMINISTRATOR RIGHTS ARE NECCESSARY FOR INDEXING FILES. YOU MUST HAVE 

ADMINISTRATOR RIGHTS TO USE WMS. 

 

2. System Requirements 

Most memory-intensive computer programs function better when large memory resources are 

available. Where'sMyStuff is no exception. It will perform much better if the following 

suggested requirements are met: 

Operating System:  Windows 2000 SP4 or greater (including Windows XP, Windows  

    Server 2003, Windows Vista and Windows 7) 

System Requirements for Windows 2000 and Windows XP 

Minimum: 500MB RAM, 20% free disk space, P4 2GHz processor  

Suggested: 1GB RAM, 100GB SATA drive, 20% free disk space, Core2 Duo 2GHz processor  

System Requirements for Windows Vista and Windows 7 

Minimum: 2GB RAM, 150GB SATA drive, 20% free disk space, Core2 Duo 3GHz  

Suggested: 4GB RAM, 250GB SATA drive, 20% free disk space, Quad Core 3GHz 
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3. Installation Guide 

After downloading the installation file from the website, follow this simple installation guide to 

install Where’sMyStuff on your computer. 

• Double-click the setup file to launch the installation wizard 

• Click Next to start the installation process 

• Select the I Accept checkbox to accept the license agreement and click Next 

• Amend your name and organization details if applicable and enter the access code 

provided to you 

• Click Next 

• After the license has been verified, you can choose to alter the folder where the 

application will be installed.  Click Browse to locate a new folder, if you so wish 

• Click Install to begin the installation process 

• The software will begin downloading – the speed will depend on your Internet 

connection 

• When the download is complete, click OK to the message window that appears 

• A window will appear while the files are being installed 

• Once the installation is complete, click OK to the message window that appears 

• Select the Run Where’sMyStuff 1.0 checkbox to start the software and click Finish 

 

The first time you run Where’sMyStuff, you will be asked whether you would like to index your 

disk.  Without indexing your disk, Where’sMyStuff will not be able to find any of the files you are 

looking for, so ensure that you select the disks you would like to index. 

 

Select the checkboxes next to the disks you would like to index and click OK.  Once the indexing 

is complete, click Close Indexer.  WMS may be launched after the indexing is complete. 
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4. Quick Start Guide 

Where'sMyStuff (WMS) is a very quick, simple to use, full-featured file search tool for 

Windows PCs. It will save you time, eliminate the headache of ‘lost’ files and help organize 

your work. 

WMS will allow you to: 

• Index a typical disk in about 5 minutes 

• Find any file on any disk in less than 2 seconds 

• Create any search in a few keystrokes 

WMS is an intuitive and easy to use application. All of the filters are on the main screen, with 

no annoying menu trees to use. The tabs appear at the top of the screen with the timeline and 

filters below. 
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Searching for files 

To search for a specific file, enter your search criteria into the selected filter fields and click the 

Search button.  The search criteria can be selected and filtered through various tabs, buttons, 

drop-down menus and fields:  

• TABS:  Select the specific tab that contains the type of file you are looking for 

 

• FILTERS:  Enter the search criteria in one of the filter fields at the bottom of the 

screen 

 

• TIME PERIOD: Adjust the timeline view by selecting the appropriate time interval 

button 

  

Click the Modified button to change the selection to Modified, Accessed or Created 

  

• TIME SPAN: Select the time frame to search by dragging the timeline markers to 

expand or shrink the selected time span 

  

• DISK:  Click the selected drive to display a list of alternative drives to search 

 

Once all the filters have been selected or entered, click the Search button.  A list of matching 

files will be displayed in the window. 

NOTE: If you select the Multimedia tab and select the Thumbnails tab for the first time 

(below the results window), you must left-click the mouse in the thumbnail window to see 

the images.  
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Working with the search results 

To open a file, double click the file name.  If a folder is displayed, double-click the folder to 

display the contents. 

The ‘drag and drop’ process from WMS works in the same way as Windows Explorer. When 

you use this process, if you drag it to a location in the same drive, the file will move from the 

original location to the new file location. If you drag the file to a different drive, it will make a 

copy of the file in the new location and leave the original file in the existing location. Files 

cannot be pasted into WMS. 

To copy a file anywhere, open the Edit menu and select Copy.  When you have located your 

target location, click Paste. 

There is no Undo function in WMS, so if you wish to reverse any file moves or deletions, you 

will need to locate the relevant files in Windows Explorer. However, for WMS to see the 

change, the disk must be re-indexed. 
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5. Conducting a Detailed Search  

1.1. Using the Timeline 

 

The Timeline is located at the bottom of the screen and is composed of the following 

components:  

• the Timeline itself, showing the days, months or years on a linear scale  

• the light blue Time Span narrows down the selected time to search. Placing 

the mouse cursor over the blue area, it may be moved left and right by 

pressing and holding the left mouse button and moving the mouse. The Time 

Span size may be changed by pressing and holding the left mouse button on 

each 'ear' and moving them in or out to stretch or shrink the selection  

• the 5 time period buttons: Days, Weeks, Months, Years and Any Time 

(select this if no time filter should be applied) 

• the Modified, Created, Accessed button, which selects which file time 

property to be applied in the search  

• the Disk button to select the disk to search  

• the Search button which will execute the search selected 

 

1.2. Using the Filters 

 

The Filters are displayed at the bottom of the screen and is composed on a number 

of fields.  These fields allow you to enter specific search criteria. 

• the File field allows you to enter specific words to search for 

• the Type field allows you to select a file type from the drop-down menu or 

enter a number of file types, separated by a  comma 

• the Dir field allows you to select a specific directory to limit the search to 

• the Size field is measured in bytes (B) and the number should be entered in 

that format – for example, to search for files that are at least 1MB in size, 

enter 1,000,000 in the Size field and select At Least from the drop-down 

menu 
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Note: Different filters will display depending on the tab selection. 

Example 1: Find all ‘.doc’ files on drive C: modified in Jan 2008 

1. Click the Documents tab 

2. Select .doc from the Type drop-down menu 

3. Select C: from the Disk button 

4. Select Months for the Time Period  

5. Adjust the width of the blue Time Span by clicking and dragging each ‘ear’ and 

ensure that January 2008 is selected in the blue area 

6. Click Search 

A list of files appears. Double-click the filename or folder to open.  

 

Example 2: Find all ‘.jpg’ files on drive D: with a name like 'jim', larger 

  than 20k, modified since Oct 2007 and in thumbnail view 

1. Click the Multimedia tab and select the bottom Thumbnails tab 

2. Enter jim in the File field 

3. Select .jpg from the Type drop-down menu 

4. Enter 20000 in the Size field and in the adjacent field, select at least from the 

drop-down menu 

5. Select D: from the Disk button 

7. Select Months for the Time Period  

8. Adjust the width of the blue Time Span by clicking and dragging each ‘ear’.  

Ensure that the left ‘ear’ starts at October 2007 and move the right ‘ear’ all 

the way to the right 

6. Click Search  

7. Click the Thumbnails window 

A display of thumbnail images appears. The preview window also appears, if you 

have enabled it. Alternatively, double-click the thumbnail image to open the file in 

the default image program.  
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2. Indexing your Drive 

The Indexer has the job of indexing your disks – that is, locating, organizing and loading files 

and folders into a database. This is what WMS uses to find your files whenever you execute a 

search. The Indexer can be launched from the File menu of WMS.  

 

When you select this, the indexer does not auto-start; you must first select the disks to index. 
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3. Menus 

Various menus allow you to adjust views, cut or copy files or print a list of the search results. 

 

FILE MENU 

Print:   

Prints search list for currently selected tab 

Note: no images will be printed 

Print Preview:  

Previews the printed search list for currently selected 

tab 

Exit:   

Quits the program 

Launch Indexer:  

Launches the WMS Indexer selection screen to view 

the currently indexed disks and their statistics or to 

select up to four NTSF formatted disk(s) to index 

 

 

EDIT MENU 

Cut: 

Deletes the group of highlighted files. Files are 

deleted to the Recycle Bin and are thus recoverable. 

To permanently delete them, delete from the Recycle 

Bin. If deleted files are restored from the Recycle Bin, 

you must run Indexer to see them in WMS. 

Copy:  

Copies the group of highlighted files. Paste them 

somewhere else, such as another folder or an 

external device like a cell phone or flash memory 

stick. 
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VIEW MENU – THUMBNAIL SETTINGS 

Preview On:  

Enables image preview window, which 

shows a larger version of the currently 

selected image in a separate window 

Preview Large:  

Toggles the large/small preview window 

Thumbnail Large:  

Toggles the large/small thumbnail 

Camera Date:  

Puts the camera date in the preview 

window title bar. The camera date is 

recorded by the camera when you take 

the picture. It will be the actual date-

time if you set the date-time in your 

camera correctly. 

Select Image by Mouseover:  

This handy little feature selects images 

displayed in the preview window by just 

hovering the mouse cursor above a 

thumbnail image. If you turn it off, you 

can either click the thumbnail or use 

the arrow keys to select it to display in 

the preview window.  
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VIEW MENU – SKINS 

Select from the Itunes, Zune, Tiger or XP 

skins. Skins are special settings that adjust 

the look and feel of the window and makes 

WMS look cool! 

ITunes:  

Zune:    

XP:  

Tiger:  

 

 

HELP MENU 

About: 

Copyright and website info 

Help: 

Access to the WMS help file 
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4. Tabs 

The purpose of the tabs is to help you organize your work. Each one is named for a particular 

class of file usage. By searching within a tab using only those search criteria appropriate for its 

class of use, you can keep your files organized. 

For example, in the Documents tab, only search for MS Office, txt, pdf, zip and files of that 

sort.  In the Images tab, only search for jpg, gif, png and that sort of file type. That way, 

whenever you click on a tab, you can be sure to find your files grouped according to that 

particular tab class. Use the Search Any tab for file types not easily classified using the other 

tabs. Then you won't end up with confusing mixes of file types in your tabs. 

Each tab can remember up to 10 searches. A search is classed as a single search character 

string like 'mydoc', or 'dsc374'.  

Only the Type field may be more than one string. In Type, you may enter up to four strings, 

separated by commas. Here is an example: doc, pdf, txt, html. Do not use quotes to enclose 

your search strings. 

Important: The Application tab will only display .exe files.  The Audio tab (on the 

Multimedia tab) will only display audio files. All the other tabs can display any file type you 

wish to search for. However, it is strongly recommended that you only use the tabs as they 

were designed - as organizational aids to help you find your files quickly. Use the Search Any 

tab for anything that does not fit into the main tab categories. 

 

4.1. Applications tab 

The Applications tab will only show .exe files. That is, executable files like 

word.exe, notepad.exe or yourapp.exe. Its purpose is to allow you to keep recently 

used applications together.  

When searching in the Applications tab if you use the Accessed setting (of the 

Modified, Created, Accessed button on the timeline bar), you will see the latest 

accessed or used application files. 

This can sometimes be thrown off by anti-virus programs, some of which will 

change the file accessed value when scanning. This is annoying as it is unnecessary 

- they should know better.  
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4.2. Documents tab 

Use the Documents tab to search for document-type files you use in your work. 

This way, you can always find your current, recent or older work files with only a 

few clicks. Like all of the tabs, the Documents tab remembers the last 10 

searches. 

Try to develop the habit of only using the tabs for the related files they were 

designed for. This will really help you with finding and organizing your files.  

 

4.3. Multimedia tab 

The Multimedia tab is a generic tab for all of your multimedia files and contains 

the following specific tabs - Audio, Images, Thumbnails and Video. These tabs are 

explained below. 

4.3.1. Audio 

 

The Audio tab displays these file types: mp3, mp4, wav, wma. It will not 

display any other file type. Use it to organize your music files. 

When the Audio tab is selected, two new filters are shown on the filter bar: 

Find and MP3Tag. Use the MP3Tag drop-down menu to select one of four 

mp3 tags for search: Artist, Title, Album or Genre. In the Find window, 

type the text to search for. 

Example: 

To display all Norah Jones songs, select Artist from the MP3 tag drop-down 

menu and type 'norah jones' in the Find window. On the Timeline, make 

sure Any Time is selected and click Search.  

All Norah Jones songs are listed. You may also use the file name, file type 

and directory filters to further refine your search.  
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4.3.2. Images 

Use the Images tab to organize your pictures. The Images tab displays 

lists of files which may be viewed by double-clicking the filename or copied 

by selecting a group of files and using Copy from the Edit menu. 

This tab is extremely useful for locating your images since digital cameras 

usually save their images with sequential coded file names, such as 

DSC0000001957.jpg. The Images tab allows you to view the content of the 

file rather than just the file name. 

Use the file name, file type, directory and size filters to build your search. 

Remember, WMS remembers the last 10 searches in each filter for use later. 

The most useful way to search your digital camera images is by using the 

Timeline in conjunction with the filters. Digital camera files will typically have 

the picture snap date in either the Modified or Created file attributes. 

To build a time-based search, first select .jpg in the Type field. Then use 

the Timeline to pick a time period (Days, Weeks, Months, Years, or Any 

Time).  Set either Modified or Created.   

Creating a suitable Timeline window, you can precisely search for just those 

pictures taken at a certain time, like August 15-22 last year or Christmas 

week. Use the Thumbnails tab to view small and large sizes of your 

selection. The images in Thumbnails always match the list in Images, and 

vice versa. 

4.3.3. Thumbnails 

 

The Thumbnails tab is the place to view your pictures. Searching in 

Thumbnails is identical to searching in images and the list in Images 

always matches the images in Thumbnails. 

Use the View menu and select an option from the Thumbnail Settings to 

change the way the thumbnails appear. You can set large or small thumbnail 
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size, set large or small preview window size, turn the preview window on or 

off and turn the mouseover feature on or off. Mouseover allows selection of a 

thumbnail by moving the mouse cursor over the image. 

The Preview window is a much larger view of the thumbnail image, in a 

medium or larger size. The currently selected thumbnail image is the one 

that displays in the Preview window. 

The thumbnail can be selected in any of three ways: by clicking the left 

mouse button over the thumbnail, by using the arrow keys or by merely 

moving the mouse cursor over the thumbnail. 

Note: Mouseover only works on currently visible thumbnails.  When using 

arrow keys for selection, make sure the mouse cursor is not in the 

Thumbnails view area or the arrow keys will get confused.  Arrow keys 

wrap from bottom to top and top to bottom. 

4.3.4. Video 

Keep track of your video files here. Although you can select any type of file 

here, it's best to only use this tab for video files. This makes it very easy to 

locate them quickly. Use the filename, file type, directory and size filters to 

select your videos. Use the Timeline to hone in on a certain time period. The 

Video tab displays a list of your search results and their locations and 

attributes.  

 

4.4. Directories 

The Directories tab is used only for finding folders. This is very handy since 

Windows Explorer is not designed to easily locate individual folders. 

The Directories tab has only one filter - the directory name. Type the full name or 

as much as you can remember. Select the appropriate time interval from the Time 

Period buttons or just select Any Time to search without time constraints. Use the 

Directories tab to organize your folders, avoid constant "drill-down" with Windows 

Explorer and quit littering your desktop with all of those open folders.  
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4.5. Search Any 

Use the Search Any tab to locate files that are not usefully assigned to any 

of the other tabs. This way, you can keep your other tabs clean, using them 

only for the files types that fit. Then you can more easily find your files yet 

still have a random type of search that will not affect the relational nature of 

the other tabs. 

 

5. Troubleshooting 

5.1. Tips 

• Install plenty of memory - 4GB or more for Windows Vista and Windows 7 and 2GB or 

more for any other operating system. Plenty of memory gives your programs a huge 

performance boost, more than upping the CPU speed. And memory is very cheap. 

• Run the indexer during low usage levels. Turn off you AV program while doing so.  

• Don't run other indexers at the same time as WMS.  

 

5.2. Known Problems or Quirks 

• Thumbnails: Sometimes, when Thumbnail search is used, the Thumbnail  

   window must be clicked with the left mouse button to display the 

   thumbnail images. 

• Search Results: Files that have been modified, moved or deleted by other  

   applications after the last indexing will not be seen in the search 

   results. You must re-index to see these files changes made  

   outside of WMS.  
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6. Frequently Asked Questions and ‘How do I’ Questions? 

Why is a WMS whole new way to search? 

With WMS, you needn't remember a file’s location to find it again. You can use WMS to find 

your files even if you don't remember their names. WMS locates files by using a combination 

of the Timeline, file time created, file type, size, partial 

name and directory.  

First, try finding your file using the Timeline. Set the 

time period to the range you think the file was created. This works great to find, say, your 

pictures of your vacation last September. Set the time span to cover last September and press 

Search and you will instantly find those files. Don't forget to select the correct disk. 

Use the Timeline with the tabs 

to narrow your search. Tabs will 

automatically narrow your 

search to the latest applications 

that you have used or any type 

of document or multimedia file (e.g. jpg with thumbnails, mp3, mpg, avi, etc.). Or you can 

view results found in a certain directory or subdirectory. 

Narrow your search even farther by using the powerful filters included in WMS. Filter by file 

name, type, size, or directory location. If you can't find it after that, maybe it can't be found! 

 

 

Can I use WMS to find the largest files on my computer? 

Yes. Click the Search Any tab, click Any Time on the Timeline, then type in a large number 

in the size filter and make sure you have At Least selected after the size number. Select your 

disk and then click Search. You will instantly see any files on your computer that are larger 

than the number you typed in. 
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What about removable disk drives and USB drives? 

WMS can index any NTFS disk volume connected to your computer. It cannot index FAT 

drives. However, FAT volumes may be converted to NTFS volumes. If your disk is not empty, 

DO NOT attempt to convert to NTFS without first searching Microsoft help and backing up the 

disk. 

When any removable drive, such as a USB, hot-swap or "disk caddy" slide-out, is disconnected 

from your computer and then reconnected, the drive assignment, that is the drive letter (C:, 

D:, etc.), may change. So a drive that used to have the letter 'E:' might, after 

disconnect/reconnect, end up as 'D:' or 'F:'. WMS does not know about this unless you re-

index the drives that have been changed. The same goes if you manually change the drive 

letter. So always re-index with WMS after any such change. 

The same is true if you power off/on a USB drive or just remove any drive - the drive letter 

assignments will change or be missing for some period. In these cases, always re-index your 

drives to insure correct searching. 

 

Why won’t' WMS find a file I just created? 

WMS won't see your file until it is indexed. Indexing is examining your whole disk and 

collecting all of the file information in a database. WMS will then use this database to find your 

files instantly. WMS has a cutting-edge indexer that scans the disk very quickly. If you want to 

find your newly created files with WMS, simply run the indexer again.  

 

Can I re-index my drives whenever I want? 

Yes. You can and should run the indexer any time you have added new files to your computer 

that you want WMS to be able to find. Simply click the File menu and select Launch Indexer. 

Select the disks you wish to re-index and check the hidden/system boxes as desired. 
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Can I manage my multimedia files with WMS? 

Click the Multimedia tab in the 

search window and then pick the 

tab for the type of file you would 

like to manage.  

Click Audio to view all of your MP3, AAC, or other audio files.  

Click Images to manage your jpgs, gifs or other images in a list format.  

Click Thumbnails to view your images as thumbnails.  

Click Video to manage your MPG videos or any other type of videos. 

 

Why would I use the Directory tab in WMS? 

Use the Directories tab to locate directories you use often or to find one you've forgotten the 

name of. This is much easier than the Windows Explorer "drill-down" we are all familiar with. 

This way, you can locate a directory instantly. Only those directories matching your filter string 

will be included in the search. 

 

How do I view all of my work files in one window, regardless of 

location? 

This is great way to use WMS. Active users deal with many different types of files in different 

places and have to keep track of them somehow. With Windows Explorer, regularly accessing 

files in different places can be a real time waster. With WMS, index often; and keep the 

Timeline set to the last couple of days; enter the appropriate file filters and select your disk. 

Then click Search and all of your work files will display in one window. Double-click to launch, 

as usual. 
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I have a lot of MP3 and JPG files. But when I search, WMS only 

shows 10,000. Why? 

Due to memory constraints and to avoid hogging memory from other windows apps, WMS 

limits any search to 10k files. To see the rest, simply alter your search strings. Or, if they are 

mostly in one folder, simply open that folder by double-clicking in the directory column. 

 

Can the filter bar be moved to the bottom? I don't like it up top. 

Yes. Using your mouse, place the cursor on the vertical ‘gripper’ symbol at the left of the filter 

bar. A cross-shape appears. Drag the filter bar down and place it below the timeline. 

 

 

Usually WMS is very fast to search. But sometimes it takes 20-30 

seconds! Why? 

There are several reasons for this: many other programs are open and using resources WMS 

needs; the disks need to "wake-up" so that WMS can check them; or a single program is 

hogging CPU and memory, such as anti-virus programs like Windows Defender. This behavior 

is not seen when these conditions are removed. Unfortantely, WMS cannot change this. 

Happily, this does not occur very often. 
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I've tried everything but I still cannot find my files! 

Of course, there is always the possibility that the file has been permanently deleted or 

removed. If this is not the case, here are the most common reasons for not finding files with 

WMS: 

• You selected the wrong disk 

If you have 3 or 4 disks, it's easy to forget to click the disk button on the Timeline to 

select the correct disk. Or you may have saved them to a different disk than you 

remember. Or you may have removed and re-attached disks without re-indexing. This 

will cause WMS to mix up the drives. The best solution is to make sure your indexing is 

up to date and to simply search each disk, in turn. 

• You set the Timeline to the wrong time span 

When you have trouble finding files, often it is due to Timeline settings. Simply click the 

'Any Time' button on the Timeline to avoid this problem. Then WMS will ignore date 

when searching for your files. 

• You made a typing error 

I know, we never make typos. We checked it twice and it's the correct search string. 

Well, check it again to be sure. 

• Wrong filter value 

You could have conducted your search with wrong text in the File field or the incorrect 

file type selected in the Type field. Check this carefully and insure that they are all set 

correctly. 
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 Index 

A 

Accessed · 8, 10, 16 

Album · 17 

Any Time · 10, 17, 18, 19, 21, 25 

Applications tab · 16 

Artist · 17 

Audio tab · 16, 17 

C 

Copy · 9, 13, 18 

Created · 8, 10, 16, 18 

Cut · 13 

D 

Days · 10, 18 

Directories tab · 19, 23 

Documents tab · 11, 16, 17 

F 

File field · 11, 25 

G 

Genre · 17 

I 

Images tab · 16, 18 

Index · 7 

Indexer · 12, 13, 22 

M 

Modified · 8, 10, 16, 18 

Months · 10, 11, 18 

Mouseover · 14, 19 

MP3 tag · 17 

Multimedia tab · 8, 11, 16, 17, 23 

S 

Search Any tab · 16, 20, 21 

Size · 11 

Skins · 15 

T 

Thumbnail Settings · 18 

Time Period · 11, 19 

Title · 17 

Type field · 16, 18, 25 

U 

Undo · 9 

V 

Video tab · 19 

W 

Weeks · 10, 18 

Windows Explorer · 9, 19, 23 

Y 

Years · 10, 18 

 


